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Q&A &
Comments Program

Notes

November 19, 2013

Keystone MacCentral
Minutes 

by Gary Brandt, Recorder

Business
Meeting

Photography
Corner

President Linda Cober will be looking into a meeting 
room at Bethany Village because of the problems we 
have encountered with the projector and slow internet 
connection in the Giant meeting room. Wendy Adams 
mentioned that her church might have a meeting room 
available.

Linda was looking for recommendations on how best to 
use a $50 Best Buy gift certificate. Consensus was to apply 
it toward an Apple TV. She was also considering an Airport 
Extreme.

Someone reported problems using Netgear routers. Dennis 
McMahon suggested that members bring their Mac-related 
gift suggestions to the December meeting. When we dis-
covered that quite a few members could not attend that 
meeting on its regularly scheduled date of December 17, 
Wendy Adams suggested that we move the meeting up 
to December 3 and hold it at the West Shore Plaza Family 
Restaurant in Lemoyne, where the board usually meets on 
the first Tuesday of the month. A show of hands supported 
that idea and we expect to see quite a few of our members 
there.

Someone asked about using a flat screen TV with a computer 
in a 10 person conference room. It was suggested that a  
55 inch model would work, with LG models being  
recommended. A model with four HDMI ports would be 
preferable and you might need a VGA port. Jim Carey 
suggested possibly using a soundbar to improve the sound 
quality coming from the TV. He recommended using an 
Apple TV with Airplay for easy setup. Airstream software 
allows you to connect an iPad.

We watched an Introduction To Photography video made 
by Joel Sartore, a photographer for National Geographic. 
He stressed that the key to good photos  was to “see well”, 
with iconic images taken that enhance the original situation. 
He said that the best way to get good images was to view 

the subject, light, background, and space in a photo as 
individual elements.

Joel said you can get starting by mastering a few key camera 
settings and then you can go back to learn more about your 
camera when you are ready to use additional features. A 
good picture combines great light, good composition, and 
an interesting subject.

He mentioned that sometimes “You gotta pet the whale”, 
explaining that there are times when it’s best to set the 
camera down and enjoy the moment.

Tim Sullivan has been using Mavericks at home and he  
explained some of its new features for us. Mavericks is a 
free 5 GB download from the App Store. Tim mentioned 
that it is always a good idea to have a backup of your cur-
rent system in case you encounter any problems with the 
Mavericks installation. He suggested backing up a copy 
of the Mavericks installer. Looking on Google for “how to 
make a bootable Mavericks install drive” before you get 
started can help. You could then put a bootable version of 
Mavericks on a flash drive.

Tom Owad suggested archiving the installer if you don’t 
want a new version to overwrite it a a later date. Dennis 
McMahon said the important stuff for the installation was 
a file called “Install ESD.dmg” in the Shared Support folder. 
You can make a DVD installation disk from that file. You 
will have to right-click or Control-click on the Installer app 
to show package contents to find that file.

Tim likes some of the features in Mavericks but he noted 
that he experiences pauses of up to ten seconds sometimes 
when changing windows on screen. Tim uses QuicKeys 
to run macros. He needed to go to the Security & Privacy 
pane of System Preferences to change the setting to allow 
QuicKeys to control his Mac. That pane now houses 
Accessibility controls. Newer macro programs might work 
better with Mavericks.

App Nap is a feature that slows down an app if it is 
completely hidden and has not been used for a while, 
ostensibly to save system resources. If you want to prevent 
App Nap from affecting an application this way, you can 
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adjust the setting on an individual app basis in its Get Info 
window.

Mavericks adds tabs to the Finder. Files can be moved by 
dragging them onto a tab. The Finder has more view 
options for column view. Files can be tagged by color 
(replaces labels) or words.

Tim showed how the Library folder in a Home folder is 
accessed. It is usually hidden in Mavericks. Bluetooth setup 
should be easier and iCloud now allows you to sync the 
Keychain.

Hard drive manufacturer Western Digital is warning users of the company’s external hard drives that there may 
be conflicts between OS X 10.9 Mavericks and the bundled utilities WD Drive Manager, WD Raid Manager, 

and WD SmartWare. These conflicts could case data loss, and until more is known, Western Digital recommends that 
users of these applications delay upgrading to Mavericks or delete the applications and restart. Thanks to reader Charlie 
Colosky for the alert!

The Dictation & Speech pane (also in Mountain Lion) is 
where you would adjust settings to convert speech to text. 
Enhanced Dictation mode allows you to talk for more than 
30 seconds, which was a prior limitation. In Tim’s experi-
ence, contractions and grammar are well handled. You still 
have to enter punctuation. Tim did report trouble trying to 
set CAPS on.

The Calendar app has been changed. If you add address 
information for an event, Maps will display a map of that 
address if it is recognized.

by Adam C. Engst

Western Digital Warns Mavericks Users 
of Data Loss

The RoaringApps software compatibility site lists WD Drive Manager as being incompatible with Mavericks, with one 
commenter claiming that Mavericks identified it as incompatible during the upgrade. The other Western Digital utilities 
either lack Mavericks-specific information or aren’t listed with RoaringApps.

[Update: 6 November 2013: Western Digital has sent out a followup email, saying that the problem is yet to be fixed, but 
affects only a small number of users. Western Digital urges customers running Mavericks to uninstall the Western Digital 
software (an uninstaller is available), reboot, and if there’s any difficulty accessing the drive, to disconnect it and contact 
customer support. The company says that lost data can likely be recovered with a data recovery utility.]
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Tags have been popular since the dawn of “Web 
2.0,” but I never quite wrapped my head 

around them. So when file tagging was announced as a 
feature of OS X 10.9 Mavericks, I wasn’t terribly excited. 
But after playing with the feature for a few weeks, my eyes 
have been opened to just how powerful tagging is.

For those not in the know, tags are a form of metadata that 
enables non-hierarchical grouping. In plain English, that 
means that you can collect files together without using 
folders, and do so in a way that’s easier and more flexible 
than working with aliases.

Why would you want to do this? Let’s say that you have a 
project that involves different kinds of files: spreadsheets, 
images, and documents. A recent example is a chart I 
prepared to compare Apple’s product sales over time. I 
compiled the data and chart in Numbers, which I saved 
into iCloud in case I needed to collaborate on it with the 
editorial staff. Next, I exported the chart as a PDF, which I 
saved in my Documents folder. Then, I converted the PDF 
to a PNG in Preview, and dropped that file into my Pictures 
folder, which the automation utility Hazel subsequently 
organized into my TidBITS Screenshots folder.

by Josh Centers

All about Tagging 
in the Mavericks Finder

I tagged each of these files as “Apple Financial,” so despite  
being scattered all around my hard drive, I can easily 
group them in one place. Admittedly, that could be accom-
plished with aliases, but tags make it so the document I 
stored in iCloud appears with all the rest, something that’s 
not possible with aliases.

Editor’s Note: I was able to determine that the hard drive in my 
desktop is a Seagate. Using the Disk Utility app, press the Info 
Button to display a window which includes the name of the drive 
(in my case “ST3500418AS Media.” Using a browser search I 
got Seagate. 

�
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“But why not just keep them all in the same folder,” you 
may ask. Well, a file can live in only one directory at a 
time. What if a file falls into different categories that make 
choosing a single location difficult? For example, I have a 
lovely engagement picture of my wife and me that makes 
for a good Desktop background. With tags, I can tag it with 
(Josh) (Hannah) (Wallpapers) (Engagement), and then store 
it in a folder of photos named for the month in which they 
were taken.

What’s most important, though, is that the tags make it 
easier for me to find that photo later, since I don’t have to 
remember exactly when it was taken. Instead, I can look 
under any of those tags to find it, along with other files that 
share the same tags.

In short, grouping files with tags makes them much easier 
to organize. You can also group folders together with tags. 
As another example, take what Adam Engst has done with 
Take Control. Each ebook’s files exist in a variety of folders, 
one for the Dropbox folder used by Leanpub, another 
shared Dropbox folder for the cover graphics, a folder 
on his local file server for the final production files, and a 
series of folders for each distribution format. With appro-
priate tags, he could collect all the folders for a particular 
book together, despite the many places in which they must 
live.

Let’s examine how you can use tags in Mavericks, from 
creating and applying your own tags to finding and working 
with tagged files and folders.

Create, Apply, and Remove Tags — Adding tags to an 
existing file is easy, which is essential, because if tagging 
takes too much time, you won’t bother. Equally important, 
for tagging to be useful, you must be consistent in your 
tagging efforts.

To start, let’s look at tagging files and folders in the Finder, 
since you’ll probably want to tag a bunch of the existing 
items with which you’re working.

The most obvious way to assign tags to files and folders 
in the Finder is by using the sidebar in Finder windows, 
which displays your tags. Drag one or more items in the 
Finder to a tag in the sidebar to assign that tag to the 
dragged files and folders. (As far as I can see, holding 
down a modifier key while dragging a file to a tag makes 
no difference.)

Otherwise, you’ll work in the tag editor, a popover with a 
text entry field and a list of existing tags. In it, you can:

•  Click a tag in the list to add it to the field. The list shows 
12 tags; if you have more, a Show All item at the end gives 
you a scrollbar to see the rest. (I’ll explain how to control 
which 12 appear here shortly.)

•  Type a few characters from a tag’s name; Mavericks 
suggests auto-completions that you can choose from with 
the arrow keys and select by pressing either Tab or Return. 
Clicking a suggestion also works. 

•  Create a new tag by typing its name and pressing Tab 
or Return or comma. Tags can have spaces in their names. 
Press Escape if you start creating a tag and want to back 
out without doing anything.

•  Remove a tag from the file by clicking it in the text field 
and pressing Delete or Forward Delete. In fact, tags work 
just like any normal text character, so you can arrow between 
them, select them with Shift-arrows, and so on.
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The tag editor appears in a variety of places in the Finder, 
but works similarly in all of them. You can invoke it in the 
following ways after selecting the items you want to tag:

•  In a Finder window, click the Edit Tags button in the 
toolbar.

•  Control- or right-click, and choose Tags from the  
contextual menu that appears.

•  Choose File > Tags.

•  Select an item, choose File > Get Info (Command-I), and 
in the Info window, click in the Add Tags field at the top.

In two of these cases — when you Control- or right-click 
an item in the Finder, and when you drop the File menu 
— you’ll also see seven favorite tags that you can click 
directly within the menu to add or remove, without hav-
ing to choose Tags. You can apply or remove only a single 
favorite tag at a time, so if you want to work with multiple 
tags, bring up the full tag editor instead. More on how to 
set favorite tags in a bit.

If you want to tag files even faster with a keyboard shortcut, 
try this tip from our pal Brett Terpstra.

•  Open the Keyboard pane of System Preferences, click 
Shortcuts at the top, and click App Shortcuts in the left 
column. 

•   Click the plus button to create a new shortcut, and 
choose Finder from the Application pop-up menu. 

•  In the Menu Title field, enter Tags… (the ellipsis character 
is necessary; get it by pressing Option-;). 

•  In the Keyboard Shortcut field, enter your desired key 
combination — a safe one that doesn’t conflict with any 
Finder defaults is Control-Shift-T — and click the Add 
button to finish. 

Now you can select items in the Finder and pull up the tag 
editor with a quick key press.

You don’t have to wait to add tags to a document you’re 
working on, since a Tags field also now appears below the 
Save As field (where you enter your file’s name) when you 
save a document. Click it to bring up the now-familiar tag 
editor.

http://brettterpstra.com/2013/10/27/speedier-file-tagging-in-mavericks/
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If you’re working in an application that supports Apple’s 
Modern Document Model, you can bring up the tag editor 
for that document by clicking the arrow to the right of the 
file name in the title bar and then clicking in the Tags field.

The presence of that arrow when you mouse over the name 
of a document in the title bar is the best indication of an 
app that supports the Modern Document Model; Apple 
apps like Pages, Keynote, Numbers, and TextEdit do, 
whereas apps with a longer lineage (and less reason to toe 
the party line) like Microsoft Word, Excel, and PowerPoint, 
along with BBEdit and Nisus Writer Pro, tend not to.

Find Tagged Files and Folders — Now that you’ve 
tagged some items, it’s time to put your tags to use. The 
main place where you interact with tags is in the Finder, 
specifically within the sidebar of Finder windows. (You  
can manage your tags in numerous ways within Finder 
windows too; I’ll get to that shortly.)

Most notably, click a tag in the sidebar to display all the 
files and folders to which that tag has been assigned. If 
you’re using tabs in the Finder, you can Command-click 
a tab in the sidebar to open it in a new tab (for full details 
about tabs, see “Using Tabs in the Mavericks Finder,” 31 
October 2013).

The only problem with using the Finder sidebar to bring 
together tagged files and folders is that you could easily 
end up with too many items sharing the same tag, ren-
dering the grouping useless. There’s no way to perform a 
more complex selection from the sidebar, such as selecting 
items that have the Red tag but don’t also have the Blue 
tag.

However, you can bring Spotlight to bear on the problem 
in two ways. First, if you click a tag in the sidebar and 
then run a Spotlight search in that window, it’s limited to 
items with that tag. That makes it easy to find specific files. 
Second, when you’re typing in the Spotlight search field, 
if you enter the first few characters of a tag name, you can 
select the Tag label to include that in a search that also 
includes filename or data criteria, for instance. As a tip, to 
search for a tag directly, it can be easiest to start your search 
with tag: and then a few characters of the tag name.

You can even search for multiple tags, as in tag:Red 
tag:Blue. Unfortunately, Apple’s support for tags in Spot-
light doesn’t seem to include Boolean operators, so you 
can’t insert NOT or OR between two tags in the search 
field for more interesting searches, such as Sharon Zardetto 
describes in her comprehensive “Take Control of Spotlight 
for Finding Anything on Your Mac.” Nor can you find 
untagged files.

One last thing. Say you’ve identified a file by clicking an 
associated tag in a Finder window’s sidebar. What if you 
want to see what other files are in its actual folder? 
Or perhaps you want to compress it or burn it to a disc? 
(Those commands disappear from the contextual menu 
because they don’t make sense on a file that has no appar-
ent location — the same is true of the results of a Spotlight 
search.) To trace back to a tagged file’s actual location on 
disk, choose File > Show in Enclosing Folder (Command-R) 
or the same command from the contextual menu. And, as 
our own Michael Cohen pointed out, you can also find the 
actual location by enabling the Path Bar in View > Show 
Path Bar (Command-Option-P). Note that you can double- 
click any folder in the Path Bar to open it.

Manage Tags — The sidebar of Finder windows provides 
direct access to numerous tag management capabilities, 
and the few things you can’t do from the sidebar are ex-
posed in the Tags pane of the Finder Preferences window. 
In the sidebar, you can:

•  Drag a tag within the sidebar to rearrange the order. 
The first 12 appear in the tag editor directly; the rest can be 
revealed by clicking Show All in the tag editor.

•  Drag a tag off the sidebar to remove it from the sidebar; 
you can also Control- or right-click it and choose Remove 
from Sidebar. This does not delete the tag or affect any files 
with that tag.

•  Control- or right-click a tag to access two other important 
commands: Rename and Delete. The former selects the 
tag’s name for editing; the latter deletes the tag and  
removes that tag from all items to which it has been assigned.

•  When you Control- or right-click a tag, you can also 
choose a color (or no color) for it from the seven available.

•  The final item in the Finder window’s sidebar is always 
All Tags. Clicking it displays yet another sidebar within 
the window that lists all your tags, in alphabetical order. 
It’s a good way to access little-used tags that you normally 
don’t want to see on the main sidebar. You can use the tags 

http://tidbits.com/article/14260
http://www.takecontrolbooks.com/spotlight%3Fpt%3DTB1200
http://www.takecontrolbooks.com/spotlight%3Fpt%3DTB1200
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in this secondary sidebar exactly as you would in the main 
sidebar, though you can’t rearrange them or remove them 
from the sidebar. (It would be logically consistent if Control-  
or right-clicking a tag that had been removed from the 
main sidebar provided an Add to Sidebar command.)

So how would you add a removed tag back to the Finder 
window’s main sidebar? For that, turn to the Tags pane of 
the Finder Preferences window; choose Finder > Preferences > 
Tags. In it, you can perform the following tasks:

•  Control sidebar visibility with the checkbox to the right 
of the tag’s name. Selected tags appear in the sidebar; 
deselected tags don’t. But what are those “partially selected” 
minus signs in the checkbox? They’re applied to newly 
created tags that you haven’t explicitly acted on in the Tags 
preference pane. If you move the tag, it becomes selected. 
John Siracusa’s description of this feature doesn’t entirely 
match with our tests, but we still agree with John that it’s a 
lousy interface.

•  Drag tags within the list to rearrange the order in which 
they appear in the sidebar. Again, the first 12 appear in the 
tag editor.

•  Rename a tag by clicking its name and giving it a new 
one. The only reserved character that you can’t use, not 
surprisingly, is the comma.

•  Change a tag’s color by clicking the colored dot to the 
left of its name and choosing a new color from the pop-up 
menu. You can’t modify the list of colors or the colors 
themselves.

•  Control- or right-click a tag if you want to delete the 
tag; the contextual menu also shows the familiar Rename 
command and lets you pick a color for the tag.

•  To set a tag as a favorite, for quick access in the Finder’s 
File and contextual menus, drag it to a particular position 

http://arstechnica.com/apple/2013/10/os-x-10-9/8/%23tags
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Every day, I figure out a new use for tags — using them 
to organize my photo collection, separate my screenshots, 
group projects, and even identify photos for later catego-
rization. For me, tagging has proven a faster and more 
effective way of organizing files than stuffing them into 
folders, and hopefully I’ve given you some ideas on how 
to put them to work. But I’m sure everyone has their own 
ideas about how best to use tags.

�

in the Favorite Tags area at the bottom of the window. 
Since favorite tags display their names in Finder menus 
only when you hover the pointer over them, assign their 
colors carefully. By default, these are set to what used to  
be Finder labels.

Speaking of the previous Finder labels, they live on as tags, 
and the ones you’ve always used are still there, although 
you may need to put them back in the order you expect 
after upgrading to Mavericks. If you’re sharing files with 
a previous version of OS X, tagged files will appear to be 
labeled with the last (in the Get Info window’s tag list) tag 
that has a color assigned to it.

Sharing Tags, for Good and Ill — So what happens if 
you share a file via e-mail, Messages, file server, Dropbox, 
or the like? It depends on whether metadata is preserved 
in the process, so tags are lost when sending a tagged file 
via e-mail or Messages, but are retained when sharing via 
a local file server, Dropbox, or external storage devices like 
hard disks and USB flash drives, even those formatted as 
FAT32. There’s one way to prevent tags from being lost, 
no matter what transfer or storage method you choose. If 
you compress a tagged file in the Finder and send the Zip 
archive to a Mavericks user, the tags are preserved and will 
appear on the other end.

As a result, it’s entirely likely that you’ll end up with a 
cornucopia of unfamiliar tags that have wormed their way 
into your system via shared files and compressed e-mail 
attachments. But be careful when deleting unfamiliar tags, 
because if a tag has come in via a shared Dropbox folder, 
for instance, deleting it will remove it from all those shared 
files, which might prove problematic for someone else’s 
workflow.

Fortunately, tags that come in via shared files are not 
displayed in your sidebar by default, so you don’t have  
to worry about colleagues adding prank tags.

Tagging It to the Next Level — Once you get the hang 
of applying tags and managing files using them, you can 
automate the process, using the recently updated Hazel 
from Noodlesoft ($28). Hazel watches folders you speci-
fy, and when files in them match criteria you’ve set, it 

performs actions on those files. The latest version of Hazel 
supports tags, so you can both perform actions based on 
the tags applied to files, and create rules that add and 
remove tags from files.

For instance, I have a Hazel rule that moves photos and 
screenshots from my Dropbox Camera Uploads folder and 
my Desktop into my Pictures folder. It then sorts PNGs 
into my Screenshots folder and JPEGs into a dated folder. 
It also tags photos as Untagged and screenshots as either 
iOS Screenshot or Mac Screenshot, depending on the file 
name. I can then easily find screenshots for either platform 
by viewing the associated tag in the Finder. As for photos, 
I can see which have the Untagged tag and apply more 
appropriate tags based on where the photos were taken or 
who is in them.

Ah, that was the day!  

There wasn’t more time in the day, 
AOL just thought you should be willing 

to let them take it all.
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by Christopher Breen

Mac 911
Keep snooping relatives out of your stuff

A reader who wishes to remain anonymous (you’ll see why 
shortly) is concerned about his curious kin. He writes:

Over the upcoming holidays, members of my extended family 
will be sharing my Mac to check their e-mail and surf the web.  
I have some files that I’d like to keep hidden from them. I’m 
particularly concerned that some of these files will appear in 
Spotlight. Is there any way to hide them?

I can recommend a few options.

The first is to force them to use your Mac’s Guest account. 
To ensure that it’s an option when your Mac starts up, 
launch System Preferences, select Users & Groups, click the 
Lock icon and enter your username and password to unlock 
the preferences, select Guest User, and enable the Allow 
guests to log in to this computer option. Additionally, click 
on Login Options and be sure that Automatic Login is off. 
If you then log out of your account, the login screen will 
display at least two accounts–yours and the Guest User 
account. To use your Mac your relations will choose that 
Guest User account and then do their business via Safari 
and webmail services.

If, for reasons best known to you, you want to let them use 
your account you can keep these files on another volume. If 
you don’t have a lot of sensitive files you could copy them 
to a USB flash drive, delete them from your Mac’s hard 
drive, and then tuck away that flash drive until the in-laws 
leave. At that point, copy them back on to your Mac.

Or you could password protect those files by placing them 
in a folder and then creating an encrypted disk image of 
that folder – a process I described a few years ago in this 
very column.

If you’re specifically worried about your files appearing in 
Spotlight, just gather them together into a folder, launch 
System Preferences, select Spotlight, click the Privacy tab, 
and drag the folder into the Spotlight window. This  
prevents Spotlight from searching the folder.

There’s one problem with this solution, however. If your 
precocious niece is familiar with the workings of the Mac 
OS (and frankly, what precocious niece isn’t?) all she need 
do is launch that same preference, click the Privacy tab, 
and take a gander at what you’ve chosen to hide (the little 
sneak!).

Fortunately, you can thwart her. Just create a folder for the 
files you wish Spotlight (and your niece) to keep its nose 
out of and append .noindex to its name (My Secrets.noindex, 

for example). This tells Spotlight to exclude the folder and 
its contents from searches. And, best of all, any folders with 
this extension will not appear in Spotlight’s Privacy tab.

How to downgrade your AirPort device’s firmware

Reader Glen Green had some difficulty with a solution I recently 
offered. He writes:

In your recent article “Troubleshooting a ‘Busy’ Time Machine 
Backup” you discussed upgrading an AirPort Time Capsule’s 
firmware. I decided to follow these instructions and discovered 
that my Time Capsule was running firmware version 7.5.2 so 
promptly updated. Now the front light just keeps flashing yellow 
and in the Airport Utility under Status, it says “No DNS Servers.” 
What do I do now?

The first thing to try is resetting your network. To do that 
you’d follow the steps I outlined in that article. First, 
power down your broadband modem as well as the Time 
Capsule. Then plug in the modem until all the correct 
lights appear. And finally plug in the Time Capsule. When 
it fully boots it should get the proper information from the 
modem.

If not you could try resetting the modem – they generally 
have a Reset button on the back or bottom. The modem, 
once restarted, will look back to your ISP to pick up the 
proper settings and then relay them to your Time Capsule. 
(Check with your ISP before doing this, however, as some 
have more complicated procedures for resetting their 
modems.)

Or–and this is really the point of this article – go back to 
the version you were using before. If I understand your 
situation correctly, the firmware you previously had on 
your Time Capsule worked perfectly well. It might again, 
and thus solve the problem.

Unlike with iOS devices where you’re stuck when you 
upgrade the device’s software, you can roll back the 
firmware on AirPort devices. And there are two ways to  
go about it.

On your Mac, launch AirPort Utility. In the window that 
appears select your Time Capsule. Hold down the Option 
key and click on the version number entry. When you do 
a menu appears that lists previous firmware versions. 
Choose the one that worked for you (in your case, 7.5.2). 
You’ll be asked to confirm that you want to do this by 
clicking a Continue button. Do that and your Time  
Capsule’s firmware will be downgraded (and, I hope,  
solve your problem).
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Troubleshooting a ‘busy’ Time Machine backup

Reader Ernest Wilson is in earnest when he says he’s having 
problems with Time Machine. He writes:

My Time Machine backup has stopped working and I don’t know 
why. I see a message about a “sparse bundle” being in use. How 
do I fix my problem?

This is most often associated with a confused AirPort Base 
Station or Time Capsule (more often with a Time Capsule 
that’s used to back up more than one Mac). The first thing 
I’d do is launch AirPort Utility (found in /Applications/
Utilities), select your base station or Time Capsule in the 
resulting window, and click on it. In the small window that 
pops up take a peek at the version number. If it’s not 7.6.4 
you should update it. Among the changes wrought by this 
update is: “Resolve(s) an issue that may cause AirPort Time 
Capsule to report that the backup disk is in use.”

To update your device just select it. If an update is available 
an Update button will appear in the resulting window. 
Click it to update the device.

If your base station or Time Capsule is already up to date 
and you’re having this problem, restart it. You do this by 
selecting it in AirPort Utility and choosing Base Station > 
Restart.

Still having problems? Try rebooting your entire network. 
Do this by depriving your network devices of power–the 
broadband modem as well as your Airport device. Then 
bring them back to life, powering up your modem first and 
waiting for it to make its Internet connection. Once it has 
made that connection plug in your base station or Time 
Capsule, wait for its lights to turn green, and then see how 
Time Machine behaves. You should no longer see the error.

[Macworld Senior Editor Christopher Breen is the author of  
“Secrets of the iPod and iTunes (6th edition),” and “The iPod 
and iTunes Pocket Guide (4th edition)” both from Peachpit Press

and

“OS X 10.5 Leopard Essential Training (video)” from lynda.
com

Find Chris’ books at www.amazon.com and www.peachpit.
com. Get special user group pricing on Macworld Magazine! 
Subscribe today at http://www.macworld.com/useroffer

Lexmark Printer Driver 2.12 for OS X
Nov 14, 2013 – 181.31 MB
System Requirements

–	 OS X Mavericks
–	 OS X Mountain Lion
–	 OS X Lion 10.7 or later
–	 OS X 10.6 or later

This download includes the latest Lexmark printing and 
scanning software for OS X Mavericks, OS X Mountain 
Lion, OS X Lion and OS X v10.6 Snow Leopard.

FujiXerox Printer Drivers 2.5 for OS X
Nov 14, 2013 – 41.51 MB
System Requirements

–	 OS X Mavericks
–	 OS X Mountain Lion
–	 OS X Lion
–	 OS X 10.6 or later

This download includes the latest Fuji-Xerox printing and 
scanning software for OS X Mavericks, OS X Mountain 
Lion, OS X Lion and OS X 10.6 Snow Leopard.

November Software Review

Apple Updates
Samsung Printer Drivers 2.6 for OS X
Nov 14, 2013 – 18.74 MB
System Requirements

–	 OS X Mavericks
–	 OS X Mountain Lion
–	 OS X Lion
–	 OS X 10.6 or later

This download includes the latest Samsung printing and 
scanning software for OS X Mavericks, OS X Mountain 
Lion, OS X Lion and OS X 10.6 Snow Leopard.

Digital Camera RAW Compatibility 5.01
Nov 12, 2013 – 6.66 MB
System Requirements

–	 OS X 10.8.5 or later
–	 OS X 10.9 or later

This update adds RAW image compatibility for the  
following cameras to
• Aperture 3 and iPhoto ‘11:
• Canon PowerShot G16
• Canon PowerShot S120
• Fujifilm X-A1
• Nikon COOLPIX P7800
• Nikon D610
• Olympus PEN Lite E-PL6

http://lynda.com/
http://lynda.com/
http://www.amazon.com/
http://www.peachpit.com/
http://www.peachpit.com/
http://www.macworld.com/useroffer
http://support.apple.com/kb/DL1397
http://support.apple.com/kb/DL904
http://support.apple.com/kb/DL905
http://support.apple.com/kb/DL1706
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Share Keystone MacCentral with other MACaholics

Name  _______________________________________________________________________

Address	_____________________________________________________________________

City ______________________________________________ State	 ___  Zip	 _____________

Home Phone ___________________________	 Day Phone ___________________________

E-mail Address  _______________________________________________________________

Date  __________________			   Is this m Renewal or m New?	

How did you hear about us?  ___________________________________________________

Dues for one person are m $20/yr.		  Family or Corporate dues are m $30/yr. 

To join Keystone MacCentral, mail 
this form with your membership dues 
(payable to Keystone MacCentral) to: 

    Keystone MacCentral
          Membership Chair
    310 Somerset Drive
    Shiresmanstown, PA 17011

Keystone MacCentral meetings are 
usually held  at 6:30 p.m. on the 3rd 
Tuesday of the month at Giant Foods, 
Trindle & 32nd, Camp Hill

• Panasonic LUMIX DMC-GX7
• Panasonic LUMIX DMC-LF1
• Sony Alpha ILCE-3000
• Sony Alpha NEX-5T

Mail Update for Mavericks
Nov 7, 2013 – 32.46 MB
System Requirements

–	 OS X Mavericks 10.9

This update improves stability and compatibility with 
Gmail, and includes fixes for users with custom Gmail  
settings.

iTunes 11.1.3
Nov 5, 2013 – 220.77 MB
System Requirements

–	 Mac OS X 10.6.8 or later

This version of iTunes resolves an issue where the equalizer 
may not work as expected and improves performance 
when switching views in large iTunes libraries. This update 
also includes additional minor bug fixes.

http://support.apple.com/kb/DL1703
http://support.apple.com/kb/DL1614

